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Introduction to Trailer Life RV Campground 
Finder™
Welcome to Trailer Life RV Campground Finder™ by Affinity Group, Inc.    Based on 
our top-selling Campground Directory, this software is an electronic version containing 
similar information.    This program provides you with an alternative way of planning your
vacations, weekend getaways, retirement plans or other RV/campground planning 
efforts.    We hope you enjoy this software and find benefit in the information it delivers.



Menu Commands
Options in the Trailer Life RV Campground Finder™ are accessed by pressing the underlined letter of 
the corresponding command, while holding down the Alt key, or by highlighting the command and 
pressing (ENTER), or by placing the mouse pointer on the desired command (or corresponding icon) and 
pressing the left mouse button.

When a main command is selected from the top line, a menu box will appear containing all the sub-
commands.    These may also be invoked using the methods described above.    When the menu box 
appears, if a marker is to the right of a command, it indicates there are more options specific to that 
command.

Trailer Life RV Campground Finder's™ pull-down menus give you easy access to groups of related 
commands.    The menu headers (File, View, Search, and Help) are located at the top of the main 
window, underneath the title bar.

To open a menu, click on its header. To select an item from the menu, move the cursor down the menu 
until the item you wish to select is highlighted, then click.

File Menu
View Menu
Search Menu
Help Menu
 
      



File Menu
These selections allow you to set the Configuration, Print Maps, Set Printer Options and Exit the program.

Note:    You can also execute this command by pressing the "ALT" and "F" keys.

Configuration
Print Setup
Exit



View Menu
These selections allow you to change the screen reference.    Establish greater or lesser detail on the map
screen.    It is possible to reverse a previous map screen or start again at the USA overview.    Specific 
views can be saved for future reference.

Note:    You can also execute this command by pressing "ALT" and "V" keys.

Zoom In
Zoom Out
Zoom USA
Zoom Last
User View



Search Menu
The Search Menu contains commands that permit you to relocate the map window to any specific point 
on the map by searching a specific topic (e.g. address, town, etc.).

Note:    You can also execute this command by pressing "ALT" and "S" keys.

Street Address
City Search
Area Code
Zip Code
Lon/Lat Search
Location Name
 



Help Menu
Choose the Help Menu from the Windows desktop menu to open the Microsoft Windows™ Help system 
contents screen. 

The About Box provides access to system information and current version data on the software.

Note:    You can also execute this command by pressing "ALT" and "H" keys.



Using The Program
The directions listed below will help guide you through the general features and functions of the Trailer 
Life RV Campground Finder™ program.    These include opening and closing the program, instructions 
on the use of the mouse, keyboard and menu commands.

Starting and Quitting Trailer Life RV Campground Finder™
Keyboard Control
Mouse Operation
Changing Program Settings (Configuration)
Recommended System Requirements



Starting and Exiting Trailer Life RV 
Campground Finder™

Start The Program

Menu Bar To open the program, click on the "Start" button on the Windows™ taskbar.    
Click "Program" on the Start Menu.    Highlight the Trailer Life RV Campground 
Finder™ program group and click on the selected program icon.

Icon To start Trailer Life RV Campground Finder™ double click on the Trailer Life 
RV Campground Finder™ icon that is located on the desktop.

Exit Program

To quit at any time, select Exit from the File Menu in the main window.    This will return you to the 
desktop.



Keyboard Control
Although Trailer Life RV Campground Finder™ is primarily a mouse-based application, in order to 
make it easier for the user, certain icon and menu based operations and actions are also available 
through select keystrokes.

Program features that can be enabled from the keyboard are:

Key          Function  
F1 Zoom In
F2 Zoom Out
F3 Zoom USA
F5 Search City
F6 Search Street Address
F7 Search Area Code
F8 Search Zip Code
F9 Search Location Name
F11 Search by Longitude/Latitude

Ctrl F File Menu
Ctrl V View Menu
Ctrl S Search Menu
Ctrl H Help Menu



Mouse Operation
Commands that use the mouse buttons operate as follows:

Left Button: In many respects it works the same as the ENTER key.

(1) With the mouse pointer on a feature and clicking the button, it selects the command.

(2) With the mouse pointer in the map window, clicking the left mouse button once re-centers the map on 
the point where the pointer was located.

(3) With the mouse pointer in the map window, it can be used to create a dynamic rectangle used as the 
Zoom window.    Holding the left button while expanding the rectangle and then releasing it at the 
desired point, zooms in to the selected area.

Right Button: In many respects it works like the ESC key.

(1) While a menu has been selected, clicking the right mouse will cancel the feature.

(2) With the mouse pointer in the map window, pressing the right mouse button performs a Zoom-Out.



Changing Program Settings (Configuration)
The configuration settings create or modify the Trailer Life RV Campground Finder™ map data path 
settings.    Click on File, Configure and choose the Map Data Drive and click on the drive where the where
the data files are located.

By selecting the Auto Detect, when the program Trailer Life RV Campground Finder™ CD-ROM disk is 
in the CD-drive, the program will automatically determine the correct path to the CD-ROM disk.



Recommended System Requirements
Computer Requirements - While any current PC system is capable of running the Trailer Life RV 
Campground Finder™, some older systems will struggle with processing and displaying map data.    
Note below guidelines: 

Operating System 
Windows 95 or higher.

CPU
While the program will run on a system with a 486-50 CPU, a Pentium CPU running 200MHz or 
faster is recommended.

Memory
Memory is a key in performance, due to the amount of memory Trailer Life RV Campground 
Finder™ requires to load and display map data.

While the program will run on a system with 16 MB of RAM, performance may be sluggish, 
especially when in large metropolitan areas due to the amount of RAM used by the map data.

For best performance, at least 32 MB of RAM is recommended.

Display
The program was designed for use on a 256-color display at a screen resolution of 800 by 600 
pixels.    For optimum display, a system capable of running a 24-bit true color palette is 
recommended.



Map View
The features listed below allow you to reposition the map image to correspond to the desired map 
viewing.    Access to these features is found on the menu bar, Map Tab and within the mouse movement.

Zoom In
Zoom Out
Zoom Last
Zoom USA
Panning



Zoom In
Clicking on the Zoom In feature, located in the View Menu, decreases the viewed portion of the drawing 
to HALF its size, showing less of the map but in more detail.    The same effect may be achieved by 
clicking on the Zoom In Icon on the Map Tab.    Also refer to mouse operation for zooming features.

Note:    You can also execute this command by pressing the "F1" key.

Mouse Operation



Zoom Out
Clicking on the Zoom Out feature, located in the View Menu, increases the viewed portion of the drawing 
to DOUBLE its size, showing more of the map but in less detail.    The same effect may be achieved by 
clicking on the Zoom Out Icon on the Map Tab.

Note:    You can also execute this command by pressing the "F2" key.

Mouse Operation



Zoom Last
Cycles current and previous views.    For example, if you have just zoomed in from the complete US 
outline to a small section of New York state, then you could cycle between the US outline and the detailed
zoom view by selection this feature or icon.    Select the Zoom Last feature from the View Menu.    The 
same effect may be achieved by clicking on the Zoom Last Icon on the Map Tab.

 



Zoom USA
Displays the entire USA Outline Map on the screen.    Select the Zoom USA feature from the View Menu.   
The command may also be invoked by clicking on the Zoom USA Icon on the Map Tab.

Note:    You can also execute this command by pressing the "F3" key.



Panning

Panning is a feature to reposition the map view.    Usually the reference is to move the map center along a
compass heading (e.g. Pan North, Pan East, etc.).    The map is always oriented with North being along 
the top of the map.    Using the mouse, place the cursor somewhere on the map.    Click the left mouse 
and the map will re-center (pan) on that point.

This feature can also be accessed by clicking on the directional pan arrows located on the Map Tab.    
Select the arrow pointing in the desired direction to pan and click the left mouse button. 



Printing
In the Trailer Life RV Campground Finder™ program, there is one print option. This will allow you to 
print the map screen and a hard copy output of the selected (highlighted) location (campground, service 
center, and attractions) fact sheet. 

To select the printer or modify printer options, select Print Setup.

Print Setup



Print Setup Fact Sheet
Opens a dialog box allowing the user to change the printer selection and modify printer options.



Searching 
The Search Menu commands allow you to relocate the map center to a specific area that is chosen by the
Search criteria.

Street Address Search
City/County Search
Area Code Search
Zip Code Search
Lon/Lat Search
Location Name Search

 



Street Address Search
Search for a user specified Street and address.    The command may be invoked by clicking on the Street 
Search Icon on the Map Tab.    Search strings entered by the user are used as sub-strings occurring 
anywhere in the Street address database.    

For example, if looking for a street West Fifth Avenue, specifying West will find EVERYTHING within the 
search area that has West in its name, i.e. West Street, West Avenue, West Fifth Ave., West 5th Ave., 
18th Street West, etc.    If, on the other hand, you specify W 5th, then none of the above streets would be 
found.    Only if a W 5th string had been coded by USGS for the street, exactly as such in the database, 
would a match be found.

It should be mentioned that there are cases where a requested street address may not be located (zero 
hits), because the data is not available in the TIGER database.    It should also be noted that the search 
operation is confined to the data currently loaded in memory.    Depending on the area of the US currently 
being viewed and the current magnification, the search area is 100-400 square miles centered around the
viewport centerpoint (or 5-10 mi radius).

The feature can also be accessed by selecting the Street Address feature in the Search Menu.    The 
same dialog box will appear.

Note:    You can also execute this command by pressing the "F6" key.



City Search
Search and reposition the map on a specific city.    The command may be invoked by clicking on the City 
Search Icon on the Map Tab.    Type in either the city name only or include the two-letter abbreviation of 
the state (e.g. CA, GA, IL, etc.) after the city name.    Use a comma to separate the city name and the 
state abbreviation (e.g. Los Angeles, CA).

The feature can also be accessed by selecting the city feature in the Search Menu.    The same dialog box
will appear.

Note:    You can also execute this command by pressing the "F5" key.



Area Code Search 
Search for a specific telephone Area Code location. The command may be invoked by selecting Area 
Code Search in the Search Menu.    Enter the area code.    You may also enter the Zoom (magnification) 
factor and the local exchange.    Click on find and the program will search and present you a list of 
locations meeting the Area Code and exchange criteria you specified.

Note:    You can also execute this command by pressing the "F7" key.
 



Zip Code Search
Go to a Specific Zip Code.    The command may be invoked by clicking on the Zip Code Search Icon on 
the Map Tab.    Type in the five-digit zip code.    After a match is found, select Goto to reposition the map.    
If the specified Zip Code is already on the screen, nothing happens.    If not, then the viewing window is 
updated so that the found Zip Code area centroid is in the map center. 

The feature can also be accessed by selecting the Zip Code feature in the Search Menu.    The same 
dialog box will appear.

Note:    You can also execute this command by pressing the "F8" key.

 



Location Name Search
Search and reposition the map image on a location based on the site name.    The command may be 
selected by clicking on the Trailer Life Directory button on the Map Tab.    Type the facility name (e.g., 
Jellystone Park) in the dialog box window.    The program will also accept a portion of the name (e.g., 
Yellow for Yellowstone).    The program will instantly search its database and present the matching results.
Scroll and select the desired site by clicking on the name using the left mouse button and the cursor icon. 
Selecting Goto location will update the map screen and the Info window on the Location Info Tab.

The feature can also be accessed by selecting Location Name feature on the Search Menu.    The same 
dialog box will appear.

Note:    You can also execute this command by pressing the "F9" key.



Tab 
To quickly alter the map view or locate information on a site location, a series of tabs can be used that 
appear on the right side of the program screen.    The user can switch between the various tabs to select 
or reference different elements of the program.    The different tabs are:

Map Tab
Location Info Tab
Products Tab



Map Tab
Many of the options available within the Trailer Life RV Campground Finder™ menus are also available
with a single mouse click on an icon in the map tab.    Trailer Life RV Campground Finder™ 
incorporates flyover hinting, i.e., when the mouse pointer is placed on a toolbox icon for more than a 
second, a message box explaining the function of that icon appears on the screen.    

Pan North Move the Viewing port one quadrant North.

Pan Northeast Move the Viewing port one quadrant Northeast.

Pan East Move the Viewing port one quadrant East.

Pan Southeast Move the Viewing port on quadrant Southeast.

Pan South Move the Viewing port one quadrant South.

Pan Southwest Move the Viewing port one quadrant Southwest.

Pan West Move the Viewing port one quadrant West.

Pan Northwest Move the Viewing port one quadrant Northwest.

Zoom USA Displays the entire USA Outline Map on the screen.    The command may
also be invoked by clicking on the Zoom USA feature.

Zoom In Decreases the viewed portion of the drawing to HALF its size, effectively 
zooming into an area to view it at greater detail.    The same effect may be achieved by clicking on the 
Zoom In Feature.

Last View Returns to the LAST (previous) magnification scale and view.    Using the 
command you may alternate between two different views (e.g. an overview and a close-up view).    This 
command may also be invoked by clicking on the Last Scale Icon.



Zoom Out Increases the viewed portion of the drawing to DOUBLE its size, 
effectively zooming away from an area to view more of it, but in less detail..    The same effect may be 
achieved by clicking on the Zoom Out feature.

Zip Code SearchSearch for a user specified Zip Code.    The command may also be invoked by 
clicking on the Search Zip Code Feature in the Search Menu.

City Search Search for a user specified city.    The command may also be invoked by 
clicking on the Search City feature in the Search Menu.

Street Search Search for a user specified Street and address.    Search strings entered 
by the user are used as sub-strings occurring anywhere in the City/Place database.    For example, if 
looking for a street West Fifth Avenue, specifying West will find EVERYTHING within the search area that 
has West in its name, i.e. West Street, West Avenue, West Fifth Ave., West 5th Ave., 18th Street West, 
etc.    If, on the other hand, you specify W 5th, then none of the above streets would be found.    Only if a 
W 5th string had been coded by USGS for the street, exactly as such in the database would be found.

Once a list of matching street blocks has been compiled, it's presented in
a dialog box.    You may sort the displayed data either alphabetically by 
name, or by distance from the viewport centerpoint, by clicking on the 
appropriate button at the bottom of the dialog box.

It should be mentioned that there are cases where a requested street 
block may not be located (zero hits), because the data is not available in 
the TIGER database.    It should also be noted that the search operation 
is confined to the data currently loaded in memory.    Depending on the 
area of the US currently being viewed and the current magnification, the 
search area is 100-400 square miles centered around the viewport 
centerpoint (or 5-10 mi radius).

The command may also be invoked by clicking on the Search Street 
feature in the Search Menu.

Location Search Search and reposition the map image on a location based on the site's 
name.    The command may also be invoked by clicking on the Search Location Name in the Search 
Menu.
 



Products Tab
Affinity Group, Inc. offers a wide selection of high quality products specifically for the RV/ Campground 
market.    These products offer assistance, information and support to help make your RV experience 
more enjoyable.    Detailed information for some of these products is delivered by clicking on the 
corresponding button.



Site Scroll Buttons  
        

By choosing one of the buttons located on the Site Scroll Icon, you can sort through the various sites that 
are viewable on the map screen in either an increasing or decreasing order.    The icon will also indicate 
the total number of viewable sites on the screen.    
 



Select Location Icon
Clicking on the Select Location Icon enables the mouse cursor to highlight a specific site within the map 
window.    Place the cursor on the desired Site icon and click with the left mouse button.    

The icon representing the selected location will be highlighted  and location information will appear 
in the Info Tab.



Goto Current Location

Selecting this feature will immediately reposition the map centered on the highlighted site.        The 
map will automatically select the highest zoom level.



Info Tab (Location Info Tab)
Detailed site information appears in the Info Tab.

Only one of the available sites can be highlighted at a time.    It is highlighted with a red, white and blue 

ring .

Site info provides detailed information, including driving directions and facilities info as shown below. This 
information can be printed using the Print Map feature.



Filter Tab (Location Info Tab)
The filter feature limits the on screen display of sites to those selected by the user.    There are two types 
of filters: Category of Sites and Facilities.

Category of Sites - View only the types of sites that have been selected.    This will allow you to more 
quickly locate those locations that you are researching.    The site types which are available are:

· Good Sam's Discount Sites Only
· Campgrounds (Parks) Only
· Service Centers Only
· Attractions Only

To unselect your filters, click on the item using the mouse and cursor.

Facilities - Limit your on-screen locations to those facilities that provide the services that you require.    
The facilities filter applies to campground sites only.    Select any one, or as many of the facilities filter 
options as desired.    To unselect an option, click on the item using the mouse and cursor. 



Legend (Location Info Tab)
This is a legend of the site icons that can be viewed on the map.    They include:

Good Sam Discount Parks

Sites Honoring the Good Sam Discount

Good Sam Discount Service Centers

Good Sam Discount Tourist Attractions

Non-Discount Parks

Non-Discount Service Centers

Non-Discount Tourist Attractions



User View
The User View command permits you to access user-defined views menu in order to define new custom 
user views, recall stored views, etc.

This option is very useful for storing view information that you can recall later.    It quickly goes to the 
desired viewport center coordinates at the desired magnification factor (which is the information saved 
with each user-defined view).    You may also assign a name to each view that facilitates recalling it later 
on.    The information for each defined view is automatically stored when leaving the program.    Up to 100 
user-defined views can be accommodated.

To name the current view, select Add View and type in the desired name and then press ENTER or click 
OK.    The typed view name should be added to the scrollable list.

The Delete View option operates on the currently highlighted User View.



Affinity Group, Inc.
Affinity Group, Inc. is pleased that you have purchased Trailer Life RV Campground Finder™ program.  
If there is a need to contact Affinity Group, Inc., choose the appropriate selection below.

Sales & Information
Technical Support
Product Registration
Database Support
License Agreement
Copyright Notice



Sales & Information

If you would like information on other products available through Affinity Group, Inc., would like to place 
an order, or have any questions, please contact us at: 

Affinity Group, Inc.
2575 Vista Del Mar Drive
Ventura, California 93001-2575

Web Site:    www.tldirectory.com

e-mail:    directory@tl.com

Phone: 800-285-4783

This number will not be able to supply you with technical support.



Technical Support
If you encounter problems or have questions regarding the installation or operation of Trailer Life RV 
Campground Finder™, please review the listing of Frequently Asked Questions (FAQ) and the sections 
of the tutorial for possible solutions.

If you still have unanswerd questions, please contact Technical Support by:

· Telephone
Technical Support is available for registered users by calling 978-738-9806
Technical Support hours are 8:00 A.M. to 5:00 P.M. ET, Monday through Friday
Prior to placing a call, please be at your computer.

· Fax 
Fax your technical support questions to    978-682-3077

· E-mail
E-mail your technical support questions to:    techsupport@chicagomap.com

Updated Frequently Asked Questions on Trailer Life RV Campground Finder™ are maintained on the 
Chicago Map web site,    www.chicagomap.com.



Database Support
The USGS Tiger Files, the primary database used by Affinity Group, Inc. map products, undergo constant 
revisions, of the local street segments within cities and towns across the nation. Revisions include the 
addition of new local roads, roadway upgrades and the expansion of the US highway network.

Affinity Group, Inc. is dedicated to maintaining a database of the highest quality and welcomes user input 
and comments.    Please send your written comments, for improving    map data only, to:

Mail

Affinity Group, Inc.
2575 Vista Del Mar Drive
Ventura, California 93001-2575

E-mail

directory@tl.com



Product Registration
If you send in your registration card, you're entitled to technical support and discounts on future updates.

Send to:

TL RV Campground Finder
2575 Vista Del Mar
Ventura, CA    93001

E-mail to:

directory@tl.com

Check out our Web Site at:    www.tldirectory.com



License Agreement
PLEASE READ THE FOLLOWING TERMS AND CONDITIONS.    THIS LEGAL DOCUMENT IS AN 
AGREEMENT BETWEEN YOU AND AFFINITY GROUP, INC. (THE "COMPANY").    BY USING THIS 
PRODUCT, YOU ARE AGREEING TO BE BOUND BY THESE TERMS AND CONDITIONS.    IF YOU DO
NOT AGREE WITH THESE TERMS AND CONDITIONS, PROMPTLY RETURN THE COMPLETE 
PACKAGE TO THE PLACE YOU OBTAINED IT FOR A REFUND.

1. GRANT OF LICENSE: In consideration of your payment of this single-user license fee, which is the 
price you paid for this product, and your agreement to abide by the terms and conditions of this 
Agreement, the Company grants to you a nonexclusive right to use and display a copy of the software 
program Trailer Life RV Campground Finder™ (hereinafter the "SOFTWARE") on a single computer 
(i.e., with a single CPU) at a single location so long as you comply with the terms of this Agreement.    The
Company reserves all rights not expressly granted to you under this Agreement.

2.    OWNERSHIP OF SOFTWARE: You own only the magnetic or physical media (the enclosed disks) on
which the SOFTWARE is recorded or fixed, but the Company retains all the rights, title, and ownership to 
the SOFTWARE recorded on the original disk and all subsequent copies of the SOFTWARE, regardless 
of the form or media on which the original or other copies may exist.    The license is not a sale of the 
SOFTWARE or any copy to you.

3.    SOFTWARE COPY RESTRICTIONS: This SOFTWARE and the accompanying printed materials and
user manual (the "Documentation") are the subject of copyright.    You may not copy or distribute the 
Documentation or the SOFTWARE, for any reason other than to make a single copy of the SOFTWARE 
for backup or archival purposes only.    You may be held responsible for any copying or copyright 
infringement which is directly or indirectly caused or encouraged by your failure to abide by the terms of 
this restriction.

4.    PRINTED MAP RESTRICTIONS: Images created with this SOFTWARE are the subject of copyright.   
You may copy and distribute original or copies of images, subject to the terms of this agreement, as long 
as each contains the appropriate copyright notice, "Copyright 2000 Affinity Group, Inc. © Copyright 
2000, Chicago Map Corporation".    You may include maps as a supplement to any printed document(s) 
from which you do not directly or indirectly receive profit or consideration.    You may not distribute map 
images with any publication that is intended to be an atlas or a collection of maps or is in any other way 
considered a map or map document.    You may be held responsible for any copying or copyright 
infringement which is directly or indirectly caused or encouraged by your failure to abide by the terms of 
this restriction.

5.    USE RESTRICTIONS: You may not install or access the software on a network, or otherwise use it on
or by more than one computer or computer terminal at the same time, unless you have a specific Network
or Multi-user License, in which case you cannot use the SOFTWARE on a network with more users than 
what you are licensed for.    You may physically transfer the SOFTWARE from one computer to another 
provided that the SOFTWARE is used on only one computer at a time.    You may copy sections of the 
mapping database onto your hard drive for the purpose of improved program performance.    The 
Company offers limited technical support regarding the copy or transfer of files onto your hard drive.    You
may not distribute copies of the SOFTWARE or Documentation to others.    You may not reverse engineer,
disassemble, decompile, modify, adapt, translate, or create derivative works based on the SOFTWARE or
Documentation without prior written consent of the Company.

6.    TRANSFER RESTRICTIONS: The enclosed SOFTWARE is licensed only to you and may not be 
transferred to any one else without the prior written consent of the Company.    Any unauthorized transfer 
of the SOFTWARE shall result in the immediate termination of this Agreement.



7.    TERMINATION: This license is effective until terminated.    This license will terminate automatically 
without notice from the Company and become null and void if you fail to comply with any provisions or 
limitations of this license.    Upon termination, you shall destroy the Documentation and all copies of the 
SOFTWARE.    All provisions of this Agreement as to warranties, limitation of liability, remedies or 
damages, and our ownership rights shall survive termination.

8.    MISCELLANEOUS: The Agreement shall be construed in accordance with the laws of the United 
States of America and the State of California and shall benefit the Company, its affiliates, and assignees.

LIMITED WARRANTY

Affinity Group, Inc. warrants that the disc on which the SOFTWARE is distributed shall, for a period of 
thirty (30) days from delivery (the "Warranty Period") be free, in normal use, from defects in material and 
workmanship.    Affinity Group, Inc. will have no responsibility to replace any disc that has been damaged 
by accident, abuse or misapplication.    If, during the Warranty Period, a defect in the disc appears, you 
may return the disc to Affinity Group, Inc. for replacement. Affinity Group, Inc. does not warrant the 
completeness or accuracy of any information contained in the map database or that the use of the 
SOFTWARE will meet your needs or that its use will be uninterrupted or error free.    The foregoing 
constitutes your sole and exclusive remedy for breach by Affinity Group, Inc. of any warranties (express or
implied) made under this License.

EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE PRODUCT IS LICENSED "AS IS," AND 
AFFINITY GROUP, INC. DISCLAIMS ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION ANY IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
FRINGEMENT.    NO AFFINITY GROUP, INC. DEALER, DISTRIBUTOR, AGENT OR EMPLOYEE IS 
AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO THE FOREGOING WARRANTY.

The information contained within the software has been derived from public records and other sources 
independent of Affinity Group, Inc.    While Affinity Group, Inc. has endeavored to include only information 
that it believes to be reliable and current it makes no representations or warranties as to the accuracy or 
completeness of such information or as to any changes that may have occurred subsequent to the date 
that such information was first obtained by the company.    In addition, actual routing and street and 
driving conditions may change at any time.    Therefore, the user is advised not to rely upon this program 
as your primary source of navigation or while in the process of driving or operating any motor vehicle.

Some states do not allow the exclusion of implied warranties or limitations on how long an implied 
warranty may last, so the above limitations and exclusions may not apply to you.    This warranty gives 
you specific legal rights, and you may also have other rights, which vary from state to state. Affinity 
Group, Inc. may, from time to time, revise or update the SOFTWARE including user documentation, and 
in so doing, incurs no obligation to furnish such revisions or updates to the customer.    To the extent that 
any of the SOFTWARE requires current data to operate according to the user documentation, if the 
customer does not obtain and install any necessary current data, Affinity Group, Inc. shall have no further 
obligation.



Copyright Notice
Trailer Life RV Campground Finder™ is a program developed by Chicago Map Corporation and 
published and distributed by Affinity Group, Inc.

Trailer Life RV Campground Finder™ 
Copyright © 2000 Affinity Group, Inc.
Copyright    © 1992-2000 Chicago Map Corporation



Optimize Program Speed
The installation program copies only a small portion of the files from the CD-ROM disk to your computer.   
The state and associated data files, which total about 600 MB, are contained on the Trailer Life RV 
Campground Finder™ CD-ROM.    Therefore, it is necessary to always have the CD in the proper drive 
and to have the data paths set properly in order for the program to access this data.    Refer to Data 
(Configurations) for more information on setting paths to the data files.    

If you have sufficient free space on your hard drive, it is possible to copy these files to the hard drive and 
reset the path so this data can be accessed from the hard drive without using the CD-ROM disk.
The following provides step-by-step instructions for copying all program and all state data files from the 
CD-ROM disk to your hard drive, and requires about 600 MB.

1. Make sure the Trailer Life CD-ROM disk is inside the drive, and the Trailer Life RV Campground 
Finder™ program is not running.

2. Double-click on 'My Computer'.

3. Double-click on your CD-ROM drive icon.

4. Right-mouse click on the folder 'Usamaps'.

5. Click 'Copy' with your left mouse button.

6 Press the 'back space' key (left pointing arrow) on your keyboard to return to the previous window.

7. Now double-click on your [C:] drive icon, or the drive where you wish to install the files.

8. Select 'Edit', then 'Paste'.    The computer will now begin to copy the following folders and their 
contents from the CD-ROM disk to your hard drive:

\USAMAPS\
\USAMAPS\DATA1
\USAMAPS\DATA2
\USAMAPS\DATA3
\USAMAPS\STATES.

This process could take a while, depending on your system.

9. Once the files have been copied, close all open windows, and start the Trailer Life RV Campground 
Finder program.

10. Select 'File',    'Configure', 'Map Data Drive', and click on the [C:] drive, or drive letter where you 
installed the files.

The program is now configured to look for its files on your hard drive.    If you receive a reminder to place 
the CD-ROM disk in the drive when you start the program, you may ignore it.

If you are limited by space, or need access to only a few states, it is possible to delete unnecessary 
states' data files from your hard drive to reduce the disk space required.

1. After copying the files to your hard drive, as outlined above, locate the folder \usamaps\states on 
your hard drive.    From the following table, locate the filenames of the states you are interested in.

2. In the states folder, locate and delete all files except the files of interest.



State File Name State File Name

Alabama 01.zpy Nebraska 31.zpy
Arizona 04.zpy Nevada 32.zpy
Arkansas 05.zpy New Hampshire 33.zpy
California 06.zpy New Jersey 34.zpy
Colorado 08.zpy New Mexico 35.zpy
Connecticut 09.zpy New York 36.zpy
Delaware 10.zpy North Carolina 37.zpy
Washington, DC 11.zpy North Dakota 38.zpy
Florida 12.zpy Ohio 39.zpy
Georgia 13.zpy Oklahoma 40.zpy
Idaho 16.zpy Oregon 41.zpy
Illinois 17.zpy Pennsylvania 42.zpy
Indiana 18.zpy Rhode Island 44.zpy
Iowa 19.zpy South Carolina 45.zpy
Kansas 20.zpy South Dakota 46.zpy
Kentucky 21.zpy Tennessee 47.zpy
Louisiana 22.zpy Texas 48.zpy
Maine 23.zpy Utah 49.zpy
Maryland 24.zpy Vermont 50.zpy
Massachusetts 25.zpy Virginia 51.zpy
Michigan 26.zpy Washington 53.zpy
Minnesota 27.zpy West Virginia 54.zpy
Mississippi 28.zpy Wisconsin 55.zpy
Missouri 29.zpy Wyoming 56.zpy
Montana 30.zpy

If you are interested in only a few states, it may be easier to initially copy only those state(s) files to the 
states folder on your hard drive.

After resetting the data path, you will only have access to those states whose files have been copied to 
the hard drive.



Frequently Asked Questions and Answers
The following is a listing of Frequently Asked Questions (FAQ) and Answers on the Trailer Life RV 
Campground Finder™ program.    An updated listing of FAQs is maintained on the Chicago Map web 
site,    www.chicagomap.com.

Q.    When I zoom in, the map turns yellow, and streets do not appear.

That is an indication that the program can’t locate the data on the CD-ROM disk. 
1.      Make sure the CD-ROM disk is in the CD-ROM drive. 
2.      In the program, select "File", "Configure", “Map Data Drive”. 
3.      Select the proper drive for the location of the map data. 

It is also possible that the cursor has zoomed to areas not in the United States such as Canada 
or Mexico.    Click the "Zoom USA" button to view the entire continent. 

If, by zooming into the desired location and the specific street you are looking for does not 
appear, but surrounding streets do, please click here for more information. 

Q.    When I search for a street or city, I get the message "No matches found".

It is possible that the program can’t locate the data on the CD-ROM disk, that the spelling is 
incorrect, or that the street or city isn’t in the database. 

1. Make sure the CD-ROM disk is in the CD-ROM drive. 
2. Check the spelling of the street or place.    Occasionally, unexpected spaces in words 
are found in the directory. For example, when looking for "DeKalb, IL", traditionally 
spelled as one word, the search option will only find it if a space is added (De Kalb, IL).
3. Simplify the search by clarifying your entries.    As an example, instead of looking for 
"South State Street" try looking for "State".

If roads do not appear, refer to the question "When I zoom in, the map turns yellow"

Q.    When I zoom in to the 3000-foot scale, I see small rectangles with numbers inside them.    
What are they, and what do the numbers mean?

The blocks indicate landmarks, and the numbers refer to a landmark type – lakes, ponds, 
schools, cemeteries, hills, etc.    If you zoom to the 1000-foot scale or less, the landmark names 
and icon will replace the numbered blocks. 

                          

Q.    Can I run the Program without a CD-ROM?

Yes.    Look in your help files, under "Optimize Program Speed" 

Q.    I think I have found a database error. What should I do?

Occasionally, there may be errors or omissions in the map database we use, or roadways that 
have yet to be added.    If you believe you found an error in the map data, we encourage you to 



print a copy of the area is incorrect, mark it with the corrections, and fax it to (978) 682-3077.    
You may also mail the corrected map to Chicago Map Corporation, 231 Sutton Street, Suite 2D, 
North Andover, MA    01845.

If you have found a problem with information pertaining to a campground, service center, or 
amusement, please notify the Good Sam Club via e-mail at books@tl.com.

Q.    Why isn’t there a shortcut on my desktop?

The Trailer Life installation program does not install a desktop shortcut. You must go to Start> Programs> 
Trailer Life RV Campground Finder.    To manually create a desktop shortcut, follow the steps below:

1. Double-click on 'My Computer'
2. Double-click on your C: drive.
3. Double-click on your 'Program Files' folder
4. Double-click on your 'Trailer Life RV Campground Finder 2001' folder.
5. Click on the 'TLCF' icon (it looks like the Good Sam's logo), drag it onto the desktop and 
release the mouse button to create the shortcut.

Q.    How do I get rid of the campgrounds and parks that are displayed on the map?

On the right-hand side of the map, click the ‘Location Info’ tab, then click on the ‘Filter’ tab.    If you
check all of the options, the campgrounds    and parks will disappear. 

Q.    Can I run the program off of the hard drive, without having to insert the CD-ROM disk?

Yes, copy the 'Usamaps' folder from the Trailer Life CD-ROM to the root directory of the hard 
drive of your choice. (note this will take up approximately 600 MB of hard drive space).    Open the
program and go to File> Configure> Map Data Drive.    Choose the hard drive that you copied the 
files.    Refer to the topic Optimize Program Speed in the Help file for more information.

Q.    When I try to find a campground, all I see on the map is a bunch of red and blue P's?    Where 
is the information?

1. Open 'Trailer Life RV Campground Finder.
2. Zoom into the city or state that you would like information on or near.
3. Select one of the P's (a campsite), by left-clicking on one of them.
4. Red, white, and blue lines will surround the selected 'P'.
5. Click on the 'Location Info' tab, located in the upper right.
6. Underneath the tab, a box will display the selected campground's information.

Q.    When I open Trailer Life RV Campground Finder, it asks me if the CD-ROM disk is in the CD-
ROM drive.    Do I have to wait the 10 seconds every time I open the program?

If the CD-ROM disk was in the drive before that message appeared, then no you don't have to 
wait.    But if you just put the CD-ROM disk in the drive when the program asked for it, then you 
should wait about 10 seconds for the CD-ROM disk to spin up to speed.



Q.    When I zoom onto a state, there are just too many campgrounds to search though.    Is there a 
way to filter through the campgrounds for certain requirements that I need in a campsite?

1. Open 'Trailer Life RV Campground Finder'.
2. Zoom to the general area or state that you are interested in.
3. To filter out unwanted campgrounds, click on the Location Info Tab in the upper-right corner.
4. Right below that are three more tabs.    Select Filter, and choose the requirements you need.    
The display will be filtered to show only those campgrounds that meet your requirements.

Q.    I know the red and blue P's are parks and campgrounds, but why are they different colors?    
Also, why are there red and blue colored symbols with S's, A's, and H's in them?

Refer to the Legend Location Info Tab for information on each symbol type.



Landmarks
Depending on the scale displayed, landmarks may appear as small solid rectangles, as numbers inside 
colored rectangles, as an icon, or as an icon with the name of the landmark.

The following is a list of all the Landmarks used and their corresponding bitmap image.

    01 airports

      02 arch

    03 area

      04 arroyo

    05 bar

    06 basin

    07 bay

    08 beach

      09 bench

      10 bend
    11 bridge

    12 building

    13 canal

    14 cape

      15 cave

    16 cemetery

    17 channel

    18 church

    19 civil

    20 cliff

      21 crater

    22 crossing

    23 dam

      24 desert

      25 dike

      26 falls



    27 flat

    28 forest

    29 gap

      30 geyser

      31 glacier

    32 gut

    33 harbor

    34 hill

    35 hospital

    36 island

    37 isthmus

    38 lake

      39 lava

    40 levee

    41 locale

      42 march

      43 meadow

    44 military

    45 mine

    46 oilfield

    47 other

    48 park

    49 pass

    50 pillar

      51 plain

    52 post office

      53 ppl

    54 range

      55 rapids

    56 reserve

    57 reservoir

    58 ridge



      59 rock

    60 school

      61 sea

      62 slope

    63 spring

    64 stream

    65 summit

    66 swamp

    67 tower

    68 trail

    69 tunnel

    70 valley

    71 well

    72 woods



Location Info Tab 
The Location Info Tab will appear on the upper right side of the screen only when the zoom level is at the 
20-mile scale or lower.    Within this tab there is detailed information on the various site locations listed in 
the Trailer Life RV Campground Finder™.

At the top of the tab there are navigation tools to help you select from the various sites that appear in the 
map view area.    Sites that are outside of the map view area can not be referenced in the Location Info 
Tab.

The navigation tools are:

 
Site Scroll Buttons - By choosing one of the arrows located on the Site Selection Icon, you can 
sort through the location sequence in either an increasing or decreasing order.

 
Select Location Icon - Clicking on the Select Location Icon enables the mouse cursor to highlight a 

specific site within the map window.    Place the cursor on the Site icon and click with the left 
mouse button.    The site will be highlighted and the location information will appear in the Site Info
Tab.

Go To Current Location Icon - Selecting this feature will reposition the map centered on the 
highlighted location.    The map will automatically select the highest zoom level.

There are additional tabs within the Location Info Tab.    These provide information on the highlighted site 
or help to filter specific types of sites that can be viewed in the map screen.    These tabs are:

Info Tab
Filter Tab
Legend Tab



Trailer Life RV Campground Finder Tutorial

Getting Started - Basics on how to use the program

Searching for a Campground or Service Center - How to locate a campground or facility by name or 
location.

Printing - How to print a map

Advanced Features - Creating User Views,    Running the program without the CD-ROM disk, Filtering the 
symbol display



Getting Started

What Does Trailer Life RV Campground Finder™ Do?

How do I display campgrounds and service centers?

How do I move around the map?

What do those red and blue symbols mean?



What does the Program do?

Trailer Life RV Campground Finder™ is designed to allow the user to search for and locate 
campgrounds and RV service centers around the United States with ease.    The database contains over 
15,500 campgrounds, RV parks, and RV service centers across America.

If you know the general area where you would like to find a campground or service center, you can 
search by state, city, address, zip code, even area code.

Do you know the name of a campground that someone recommended last year, but can't remember 
where it is?      Use Location Search, and enter the campground name.    Perhaps you only remember 
part of the name - no problem.    Location Search will find any campground with the word or phrase you 
provide as part of the name.

Looking for campgrounds near an attraction?    Enter the name, such as Disneyland or Kennedy Space 
Center, and get a listing of campgrounds in the area.

Perhaps you're interested in campgrounds having electric and water hookups.    Simply set the 
appropriate Filters and only those sites that meet your needs are displayed.



How do I display Campgrounds and Service
Centers?
When Trailer Life RV Campground Finder is first launched, the screen will display a view of the 
continental United States.    You'll notice that the map scale in the upper left corner of the screen shows 
500 miles.    In order for campgrounds and service center markers to be displayed, you must zoom in to at
least the 20-mile scale.    

At the 20-mile scale, you'll see red and blue circles, squares, and triangles that represent parks, service 
centers, and tourist attractions - provided there are any in the area you are looking.    You'll notice that a 
"Location Info" tab has been added to the top right of the display.

As you zoom in to the 5-mile scale, the red and blue symbols will display a letter identifying the facility 
type.    

At the 2-mile scale, the location names will be displayed for each facility.

If red or blue symbols are displayed, one of them will be surrounded or highlighted in a red, white and 

blue wreath  .    If you click on the Location Info tab, the information for the highlighted location will 
appear in the Info Tab.

 At the top of the Location Info Tab, are the Site Scroll Buttons.    Clicking on either arrow 
will scroll through the onscreen locations, displaying the highlighted location's information in the Site Info 
Tab.

 To the right of the Site Scroll buttons, is the Select Location Icon.      Clicking on the Select Location 
Icon first, and then clicking on a Site icon will highlight that site and display its location information in the 
Site Info Tab.

    To the far right, is the GoTo Current Location Icon.    Clicking on this icon will reposition the map 
display so it is centered on the highlighted facility's location.    The map will automatically select the 
highest zoom level.



Moving about the map

Two terms used by the program which describe moving about the map are zoom and pan.

Moving in closer to display a smaller area but in more detail is referred to as Zooming In.    Likewise, 
moving out to display a larger area in less detail is referred to as Zooming Out.

Repositioning the map - moving the display up or down, left, or right - while at the same scale or level of 
detail is called Panning.

There are many ways to zoom and pan with Trailer Life RV Campground Finder™  - by clicking on 
icons located on the Map tab on the right side of the screen, use of function keys, mouse buttons, and 
menu commands.    You choose the method that is most convenient for you.

 Zoom In
Zoom In decreases the viewed portion of the drawing to half its size, but displayed in greater detail.    This 
may be accomplished by clicking on the Zoom In icon shown above, selecting the View, Zoom In menu 
command, or by pressing the "F1" Function Key.

The mouse can also be used to zoom in to a specific area by creating a dynamic rectangle used as the 
Zoom window.    With the mouse pointer in the map window, holding the left button while expanding the 
rectangle and then releasing it at the desired point.    The enclosed area is redisplayed in the map window
in the largest scale possible.

 Zoom Out
Zoom Out increases the viewed portion of the drawing to double its size, but displayed in less detail.    
This may be accomplished by clicking on the Zoom Out icon shown above, selecting the View, Zoom Out 
menu command, or by pressing the "F2" Function Key.

The mouse can also be used to Zoom Out by clicking the right mouse button in the map window.

 Zoom USA
Zoom USA displays the entire USA Outline Map on the screen.    This may be accomplished by clicking on
the Zoom USA icon shown above, selecting the View, Zoom USA menu command, or by pressing the "F3"
Function Key.



PANNING

Panning is a feature to reposition the map view.    Usually the reference is to move the map center along a
compass heading (e.g. Pan North, Pan East, etc.).    The map is always oriented with North being along 
the top of the map.    

This feature can also be accessed by clicking on the directional pan arrows located on the Map Tab.    
Select the arrow pointing in the desired direction to pan and click the left mouse button. 

The mouse can also be used to pan the display.    Place the mouse cursor on the map in the direction you 
wish to pan, e.g., at the right edge of the map.    Click the left mouse button, and the map will re-center 
itself on that point.

 Last View
The Last View cycles the display between the current and previous views.    For example, if you have just 
zoomed in from the complete US outline to a small section of New York state, then you could cycle 
between the US outline and the detailed zoom view by using Last View.

Click on the Last View icon above, or select the View, Zoom Last menu command.



What do the symbols mean?

At the 20-mile scale and below, you'll see red and blue circles, squares, and triangles 
that represent parks, service centers, and tourist attractions as shown below.

Good Sam Discount Parks

Sites Honoring the Good Sam Discount

Good Sam Discount Service Centers

Good Sam Discount Tourist Attractions

Non-Discount Parks

Non-Discount Service Centers

Non-Discount Tourist Attractions

One of the symbols will be surrounded or highlighted in a red, white and blue wreath  .    If you click 
on the Location Info tab, the information for the highlighted location will appear in the Info Tab.



Searching for A Campground or Service 
Center

Searching by Campground or Service Center Name

Searching by Area (Place, Zip Code, Area Code, or Map Coordinate)



Searching by Campground or Service 
Center Name

If you know the name - or part of the name - of a campground or service center, the Location Search is 
the quickest way to locate and reposition the map image to the site.    This method may also be used to 
display facilities based on area keywords, destination location, and city.

The Location Search command may be selected by clicking on the Trailer Life Directory button (shown 
above) on the Map Tab, by selecting the Search, Location Name menu command, or by pressing the F9 
Function Key.

In the dialog box that is displayed, enter the facility name (e.g., Jellystone Park) in the dialog box window. 
The program will automatically search its database and present the matching results of its search.    Scroll
and select the desired site by clicking on the name using the left mouse button.    Selecting the Goto 
Location button or simply double clicking the name will update the map screen to display the location.    
The location's information will display in the Info window on the Location Info Tab.

If you enter a partial name, say Sawmill, the program will return any location matches that either start with
Sawmill, or contain Sawmill as a keyword.

If the location doesn't start with Sawmill, but you know Sawmill is part of the name, type Sawmill, but click 
on the Partial Name Search box to enable it.    This time, the search will return additional locations that 
contain "sawmill" as any part of its name.

You can also enter a destination location or city for a match as well.    If you enter "Hyannis", the search 
will return those facilities that are either in Hyannis (MA) or report that they are in the area of Hyannis or 
Cape Cod.

Lastly, you can search for locations such as "Kennedy Space Center".    The program will return those 
facilities that are in the area of the Kennedy Space Center.



Searching For Campground or Service 
Center by Area
If you don't know the name of a campground or service center, or are looking for facilities in a certain area
of the country, the following commands will let you searching and display a map by City, Street, Zip Code, 
Area Code, or Map Coordinate.

Once in the general area, remember that you'll need be at the 20-mile scale or closer to in order for the 
location symbols to display.

As a hint when performing any of the following searches, the common search dialog used by all searches 
contains an optional Zoom Factor.    This is the scale factor that will be used when you tell the program to 
go to the selected city, address, etc.

If you are looking for a campground near a city, it is best to set the zoom scale to a value of about 5 or 10 
miles.    This will re-center the map and display all facilities in about a 10 to 20-mile radius of the city.    You
can then zoom in on the ones that interest you.

If your zoom scale is set to 0.1 mile, your map will display the downtown area in street level detail, but you
likely won't find too many campgrounds in the middle of the city.    You'll need to zoom out to display the 
facilities.

 City Search
Search and reposition the map on a specific city.    Type in either the city name only or include the two-
letter abbreviation of the state (e.g. CA, GA, IL, etc.) after the city name.    Use a comma to separate the 
city name and the state abbreviation (e.g. LOS ANGELES, CA).

The command may be invoked by clicking on the City Search Icon on the Map Tab, by selecting the city 
feature in the Search Menu, by pressing the F5 Function Key.

    Street Search
Search for a user specified street and address.    When entering an address to search for, the following 
guides may help:

· Enter street number, street name, city, state, zipcode separated by commas
· Abbreviate street as st, avenue as ave, road as rd, etc.    Don't use period after abbreviation
· Use two-letter state abbreviations.    Don't include period after abbreviation

If you are unsuccessful in performing a street search, try omitting the street number, or north, south, east, 
west from the street name.    You can choose the appropriate location from the list of matches.

The command may be invoked by clicking on the Street Search Icon shown above.      The feature can 
also be accessed by selecting the Street Address command in the Search Menu, or by pressing the "F6" 
key.



Area Code Search
Search for a specific telephone Area Code location.      Enter the area code and optionally enter the local 
exchange.    Click on find and the program will search and present you a list of locations meeting the Area 
Code and exchange criteria you specified.

The command may be invoked by selecting Area Code Search in the Search Menu, or by pressing the F7
Function Key.

  Zip Code Search

Go to a specific Zip Code.    Type in the five-digit zip code.    After a match is found, select Goto to 
reposition the map.    If the specified Zip Code is already on the screen, nothing happens.    If not, then the
viewing window is updated so that the found Zip Code area centroid is in the map center. 

The command may be invoked by clicking on the Zip Code Search Icon above.      The command can also
be accessed by selecting the Zip Code feature in the Search Menu or by pressing the F8 Function Key.

Lon/Lat Search
This feature repositions the map view based upon a specific Longitude/Latitude coordinate.    The user is 
presented with a dialog box where the desired longitude and latitude, separated by a comma, may be 
entered.    There are three different longitude/latitude formats that can be input.    An improper format will 
result in an incorrect placement.

Longitude/Latitude Coordinate Format Examples:

-87.66342,41.99654 DEG.DDD
-87:35.22,41:59.332 DEG:MIN.MM
-87:35:13,41:59:18 DEG:MIN:SEC



Lon/Lat Search
This feature repositions the map view based upon a specific Longitude/Latitude coordinate.    The user is 
presented with a dialog box where the desired longitude and latitude, separated by a comma, may be 
entered.

There are three different longitude/latitude formats that can be input:    Degrees.Decimal Degrees 
(DEG.DDD), Degrees:Minutes.Decimal Minutes (DEG:MIN.MM), and Degrees:Minutes:Seconds 
(DEG:MIN:SEC).

An improperly formatted coordinate will result in an incorrect placement.    Exmaples of valid 
Longitude/Latitude coordinate formats are:

-87.66342,41.99654 DEG.DDD
-87:35.22,41:59.332 DEG:MIN.MM
-87:35:13,41:59:18 DEG:MIN:SEC



Advanced Tutorial Topics
User Views - What are they and how do I use them?

No CD-ROM Disk - Can I run the program without the CD-ROM disk?

Using Filter Option - Display only campgrounds or facilities that meet your needs.



Creating and Using "User Views"
The User View command permits the user to define and save maps views that you would like to be able 
to recall and view in the future.

You assign your own name to each view that facilitates recalling it later on, such as a campground or 
attraction name. The information for each defined view is automatically stored when leaving the program. 
Up to 100 user-defined views can be accommodated.

To create a user view that you would like to be able to quickly access in the future, first set the map 
display that you want to save.    Click on 'View' then click on 'User View' then click on 'Add View'.

A box will appear asking you to select a name for the view you want to save, just type in a name and 
click 'Ok'.

Now, any time you open the program you can quickly access the view you saved by clicking on 'View' 
then click on 'User View' then click on the named view that you created.

To delete a user view, first open and display the view to be deleted.    Then reselect 'View' then click on 
'User View' then click on 'Delete Viewname'.



Can I run the program without the CD-ROM
disk?

The setup program only installs a small portion of the data files necessary to run Trailer Life RV 
Campground Finder™ onto your hard drive.    There is about 600 MB worth of data and index files on the
CD-ROM disk that are not installed, but are required to run the program, which is why you are prompted 
to have the CD-ROM disk in the CD-ROM drive when you start the program.

With larger hard drives becoming more commonplace, installing an additional 600 MB is no longer a 
concern for many.    It may be a desirable option for laptop/notebook PC users who are on the go, and 
don't want to have to carry the CD-ROM with them.

If you are limited by space, or need access to only a few states, instructions for copying the necessary 
program and selected states' data files to your hard drive are provided in the Help file, under the topic 
Optimize Program Speed.

The following provides step-by-step instructions for copying all program and all state data files from the 
CD-ROM disk to your hard drive, and requires about 600 MB.

1. Make sure the Trailer Life CD-ROM disk is inside the drive, and the Trailer Life RV Campground 
Finder™ program is not running.

2. Double-click on 'My Computer'.

3. Double-click on your CD-ROM drive icon.

4. Right-mouse click on the folder 'Usamaps'.

5. Click 'Copy' with your left mouse button.

6. Press the 'back space' key (left pointing arrow) on your keyboard to return to the previous window.

7. Now double-click on your [C:] drive icon, or the drive where you wish to install the files.

8. Go to 'Edit', then to 'Paste'.    The computer will now begin to copy the files to the hard drive.    This 
process could take a while, depending on your system.

9. Once the files have been copied, close all open windows, and start the Trailer Life RV Campground 
Finder program.

10. Select 'File',    'Configure', 'Map Data Drive', and click on the [C:] drive, or drive letter where you 
installed the files.

The program is now configured to look for its files on your hard drive.      You will still receive the reminder 
to place the CD-ROM disk in the drive each time you start the program, however, you may ignore it.



Using the Filter Options
Display only the campgrounds or facilities that meet your needs.

Sometimes if you go to an area of the map, there might be symbols representing tens of campgrounds or 
facilities that may be interesting.    But you need water and electric hookups.    How do you know which 
ones meet your needs without having to search the description of each facility?    Or, perhaps you want to 
see only service centers or attractions.    There must be a way to limit the display to only those facilities 
that are of interest.

The filter feature limits the on screen display of sites to those matching search criteria selected by the 
user.    There are two types of filters - Category of Sites, and Facilities.

Category of Sites - View only the type of sites that have been selected:    Good Sam's Discount Sites 
and/or Campgrounds (Parks); Service Centers; or Attractions only.

Facilities -View only the campground sites that provide the services you require.    Select one or several
service options as desired.

 



How to Print out a Map
Printing a map of the currently displayed screen is accomplished by the File, Print Map command.    The 
map will be printed according to the current printer option settings.

To change the orientation of the map, either landscape or portrait, select a different printer or modify 
printer options, use the File, Print Setup command.

If there is a selected (highlighted) facility displayed on screen (campground, service center, attractions), 
the fact sheet for that facility will also be printed on the map.






